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1 Introduction And Scope

Reflex is the ESO Recipe Flexible Execution Workbench, an environment to run ESO VLT pipelines which
employs a workflow engine to provide a real-time visual representation of a data reduction cascade, called a
workflow, which can be easily understood by most astronomers. The basic philosophy and concepts of Reflex
have been discussed by Freudling et al. (2013A&A...559A..96F). Please reference this article if you use Reflex
in a scientific publication.

Reflex and the data reduction workflows have been developed by ESO and instrument consortia and they are
fully supported. If you have any issue, please contact usd-help@eso.org for further support.

This document is a tutorial designed to enable the user to employ the FORS2 workflow to reduce his/her data in
a user-friendly way, concentrating on high-level issues such as data reduction quality and signal-to-noise (S/N)
optimisation.

A workflow accepts science and calibration data, as downloaded from the archive using the CalSelector tool1

(with associated raw calibrations) and organises them into DataSets, where each DataSet contains one science
object observation (possibly consisting of several science files) and all associated raw and static calibrations
required for a successful data reduction. The data organisation process is fully automatic, which is a major
time-saving feature provided by the software. The DataSets selected by the user for reduction are fed to the
workflow which executes the relevant pipeline recipes (or stages) in the correct order. Full control of the various
recipe parameters is available within the workflow, and the workflow deals automatically with optional recipe
inputs via built-in conditional branches. Additionally, the workflow stores the reduced final data products in a
logically organised directory structure employing user-configurable file names.

The FORS2 Reflex workflow described in this tutorial supports the reduction of FORS2 spectropolarimetric
observations (PMOS). The user is referred to the FORS2 user manual (Saviane. 2012 2 for more information on
the instrument itself, and the FORS2 pipeline user manual (Izzo et al. 20123) for the details of the spectroscopic
FORS2 pipeline recipes. There are also other tutorials that guide you through the MOS/MXU/LSS workflow
and the PMOS workflow respectively. Check the ESO pipeline main webpage.

The quick start section (see Section 4) describes the minimum effort to get started, and it makes up only two
pages of text in this tutorial.

1http://www.eso.org/sci/archive/calselectorInfo.html
2available at

http://www.eso.org/sci/facilities/paranal/instruments/fors2/doc
3available at ftp://ftp.eso.org/pub/dfs/pipelines/fors/fors-pipeline-manual-5.3.pdf

mailto:usd-help@eso.org
http://www.eso.org/sci/archive/calselectorInfo.html
http://www.eso.org/sci/facilities/paranal/instruments/fors2/doc
ftp://ftp.eso.org/pub/dfs/pipelines/fors/fors-pipeline-manual-5.3.pdf
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2 Software Installation

Reflex and the workflows can be installed in different ways: via package repositories, via install_esoreflex
script or manually installing the software tar files.

The recommended way is to use the package repositories if you operating system is supported. The macports
repositories support OS X, while the rpm/yum repositories support Fedora 20/21/22/23. For any other operat-
ing system it is recommended to use the install_esoreflex script.

2.1 Installing Reflex workflows via macports

This method is supported for OS X operating system. It is assumed that macports (http://www.macports.org)
and java are installed. If you have any problem with this installation method, please read the full documentation
at
http://www.eso.org/sci/software/pipelines/installation/macports.html.

For a quick installation, the following steps will install the ESO pipeline macports repository, the FORS2
pipeline, including the Reflex workflow support and Reflex itself:

• Set up the repository:

# curl ftp://ftp.eso.org/pub/dfs/pipelines/repositories/macports/setup/Portfile -o Portfile
# sudo port install
# sudo port sync

• Install the FORS2 pipeline:
# sudo port install esopipe-fors-all

2.2 Installing Reflex workflows via rpm/yum

This method is supported for Fedora 20/21/22/23 operating systems. If you have any problem with this installa-
tion method, please read the full documentation at
http://www.eso.org/sci/software/pipelines/installation/rpm.html.

For a quick installation, the following steps will install the ESO pipeline rpm repository, the FORS2 pipeline,
including the Reflex workflow support and Reflex itself:

• Set up the repository for Fedora 20/21:

# sudo yum install yum-utils
# sudo yum-config-manager \

--add-repo=ftp://ftp.eso.org/pub/dfs/pipelines/repositories/fedora/esorepo.repo

• Set up the repository for Fedora 22/23:

# sudo dnf install dnf-plugins-core
# sudo dnf config-manager \

--add-repo=ftp://ftp.eso.org/pub/dfs/pipelines/repositories/fedora/esorepo.repo

http://www.macports.org
http://www.eso.org/sci/software/pipelines/installation/macports.html
http://www.eso.org/sci/software/pipelines/installation/rpm.html
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• Install the FORS2 pipeline (Fedora 20/21):
# sudo yum install esopipe-fors-all

• Install the FORS2 pipeline (Fedora 22/23):
# sudo dnf install esopipe-fors-all

2.3 Installing Reflex workflows via install_esoreflex

The software pre-requisites for Reflex 2.8.2 may be found at:
http://www.eso.org/sci/software/pipelines/reflex_workflows

To install the Reflex 2.8.2 software and demo data, please follow these instructions:

1. From any directory, download the installation script:

wget ftp://ftp.eso.org/pub/dfs/reflex/install_esoreflex

2. Make the installation script executable:

chmod u+x install_esoreflex

3. Execute the installation script:

./install_esoreflex

and the script will ask you to specify three directories: the download directory <download_dir>, the
software installation directory <install_dir>, and the directory to be used to store the demo data
<data_dir>. If you do not specify these directories, then the installation script will create them in the
current directory with default names.

4. You will be asked whether you want to use your Internet connection. Unless you want to reuse already
downloaded packages (only advanced users), use the default Yes.

5. You will be given a choice of pipelines (with the corresponding workflows) to install. Please specify the
numbers for the pipelines you require, separated by a space, or type “A” for all pipelines.

6. For the pipelines to be installed you will be prompted for the demo data sets to be installed. Type “A” for
all demo datasets. Take into account that if you are installing in a directory that already contains data, it
won’t be removed.

7. The script will also detect whether previous versions of the workflows or Reflex were installed and in this
case you have the option to update links or remove obsolete cache directories. It is advised to use the
defaults.

8. To start Reflex, issue the command:

http://www.eso.org/sci/software/pipelines/reflex_workflows
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<install_dir>/bin/esoreflex

It may also be desirable to set up an alias command for starting the Reflex software, using the shell com-
mand alias. Alternatively, the PATH variable can be updated to contain the <install_dir>/bin
directory.
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3 Demo Data

Together with the pipeline you will also receive a demo data set, that allows you to run the Reflex FORS2
workflow without any changes in parameters. This way you have a data set to experiment with before you start
to work on your own data.

Note that you will need a minimum of ∼0.5 GB, ∼0.6 GB and ∼1 GB of free disk space for the directories
<download_dir>, <install_dir> and <data_dir>, respectively. The FORS2 demo data have been
retrieved with the CalSelector tool4.

4http://www.eso.org/sci/archive/calselectorInfo.html

http://www.eso.org/sci/archive/calselectorInfo.html
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4 Quick Start: Reducing The Demo Data

For the user who is keen on starting reductions without being distracted by detailed documentation, we describe
the steps to be performed to reduce the science data provided in the FORS2 demo data set supplied with the
Reflex 2.8.2 release. By following these steps, the user should have enough information to attempt a
reduction of his/her own data without any further reading:

Figure 4.1: The empty Reflex canvas.

1. Start the Reflex application:

esoreflex &

The empty Reflex canvas as shown in Figure 4.1 will appear.

2. Now open the FORS2 workflow by clicking on File -> Open File, selecting first fors-5.3.5
and then the file fors_pmos.xml in the file browser. You will be presented with the workflow canvas
shown in Figure 4.2. Note that the workflow will appear as a canvas in a new window.

3. To aid in the visual tracking of the reduction cascade, it is advisable to use component (or actor) highlight-
ing. Click on Tools -> Animate at Runtime, enter the number of milliseconds representing the
animation interval (100 ms is recommended), and click OK .

4. Under “Setup Directories” in the workflow canvas there are seven parameters that specify important direc-
tories (green dots). Setting the value of ROOT_DATA_DIR is the only necessary modification if you want
to process data other than the demo data5, since the value of this parameter specifies the working direc-
tory within which the other directories are organised. Double-click on the parameter ROOT_DATA_DIR
and a pop-up window will appear allowing you to modify the directory string, which you may either edit
directly, or use the Browse button to select the directory from a file browser. When you have finished,
click OK to save your changes.

5If you used the install script install_esoreflex, then the value of the parameter ROOT_DATA_DIR will already be set
correctly to the directory where the demo data was downloaded.
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5. Click the button to start the workflow

6. The workflow will highlight the Data Organiser actor which recursively scans the raw data di-
rectory (specified by the parameter RAW_DATA_DIR under “Setup Directories” in the workflow can-
vas) and constructs the DataSets. Note that the raw and static calibration data must be present either
in RAW_DATA_DIR or in CALIB_DATA_DIR, otherwise DataSets may be incomplete and cannot be
processed. However, if the same reference file was downloaded twice in different places this creates a
problem as Reflex cannot decide which one to use.

7. The Data Set Chooser actor will be highlighted next and will display a “Select Datasets” window
(see Figure 4.3) that lists the DataSets along with the values of a selection of useful header keywords6.
The first column consists of a set of tick boxes which allow the user to select the DataSets to be processed.
By default all complete DataSets which have not yet been reduced will be selected.

8. Click the Continue button and watch the progress of the workflow by following the red highlighting
of the actors. A window will show which DataSet is currently being processed.

9. When the reduction of the current DataSet finishes, a pop-up window called Product Explorer will appear
showing the datasets which have been so far reduced together with the list of final products. This actor
allows the user to inspect the final data products, as well as to search and inspect the input data used to
create any of the products of the workflow. Figure 4.4 shows the Product Explorer window.

10. The workflow will continue with the remaining DataSets following the same steps described above.

11. After the workflow has finished, all the products from all the DataSets can be found in a directory under
END_PRODUCTS_DIR with the named with the workflow start timestamp. Further subdirectories will
be found with the name of each DataSet.

Well done! You have successfully completed the quick start section and you should be able to use this knowledge
to reduce your own data. However, there are many interesting features of Reflex and the FORS2 workflow
that merit a look at the rest of this tutorial.

6The keywords listed can be changed by right-clicking on the DataOrganiser Actor, selecting Configure Actor, and then
changing the list of keywords in the second line of the pop-up window.
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Figure 4.2: FORS2 workflow general layout.

Figure 4.3: The “Select Datasets” pop-up window.
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Figure 4.4: The Product Explorer shows all datasets reduced in previous executions together with the full
reduction chain for all the pipeline products.
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5 About The Reflex Canvas

5.1 Saving And Loading Workflows

In the course of your data reductions, it is likely that you will customise the workflow for various data sets, even
if this simply consists of editing the ROOT_DATA_DIR to a different value for each data set. Whenever you
modify a workflow in any way, you have the option of saving the modified version to an XML file using File
-> Export As (which will also open a new workflow canvas corresponding to the saved file). The saved
workflow may be opened in subsequent Reflex sessions using File -> Open. Saving the workflow in the
default Kepler format (.kar) is only advised if you do not plan to use the workflow in another computer.

5.2 Buttons

At the top of the Reflex canvas are a set of buttons which have the following useful functions:

• - Zoom in.

• - Reset the zoom to 100%.

• - Zoom the workflow to fit the current window size (Recommended).

• - Zoom out.

• - Run (or resume) the workflow.

• - Pause the workflow execution.

• - Stop the workflow execution.

The remainder of the buttons (not shown here) are not relevant to the workflow execution.

5.3 Workflow States

A workflow may only be in one of three states: executing, paused, or stopped. These states are indicated by the

yellow highlighting of the , , and buttons, respectively. A workflow is executed by clicking the
button. Subsequently the workflow and any running pipeline recipe may be stopped immediately by clicking the

button, or the workflow may be paused by clicking the button which will allow the current actor/recipe
to finish execution before the workflow is actually paused. After pausing, the workflow may be resumed by

clicking the button again.
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6 The FORS2 Workflow

The FORS2 workflow canvas is organised into a number of areas. From top-left to top-right you will find
general workflow instructions, directory parameters, and global parameters. In the middle row you will find five
boxes describing the workflow general processing steps in order from left to right, and below this the workflow
actors themselves are organised following the workflow general steps.

6.1 Workflow Canvas Parameters

The workflow canvas displays a number of parameters that may be set by the user. Under “Setup Directo-
ries” the user is only required to set the RAW_DATA_DIR to the working directory for the DataSet(s) to be
reduced, which, by default, is set to the directory containing the demo data. The RAW_DATA_DIR is recur-
sively scanned by the Data Organiser actor for input raw data. The directory CALIB_DATA_DIR, which
is by default within the pipeline installation directory, is also scanned by the Data Organiser actor to find
any static calibrations that may be missing in your DataSet(s). If required, the user may edit the directories
BOOKKEEPING_DIR, LOGS_DIR, TMP_PRODUCTS_DIR, and END_PRODUCTS_DIR, which correspond
to the directories where book-keeping files, logs, temporary products and end products are stored, respectively
(see the Reflex User Manual for further details; Forchì (2012)).

There is a mode of the Data Organiser that skips the built-in data organisation and uses instead the data or-
ganisation provided by the CalSelector tool. To use this mode, click on Use CalSelection associations
in the Data Organiser properties and make sure that the input data directory contains the XML file down-
loaded with the CalSelector archive request.

Under the “Global Parameters” area of the workflow canvas, the user may set the FITS_VIEWER parameter to
the command used for running his/her favourite application for inspecting FITS files. Currently this is set by
default to fv, but other applications, such as ds9, skycat and gaia for example, may be useful for inspecting
image data. Note that in general it is recommended to specify the full path to the visualization application.

By default the EraseDirs parameter is set to false, which means that no directories are cleaned before
executing the workflow, and the recipe actors will work in Lazy mode (see Section 6.2.4), reusing the previous
pipeline recipe outputs where input files and parameters are the same as for the previous execution, which saves
considerable processing time. Sometimes it is desirable to set the EraseDirs parameter to true, which
forces the workflow to recursively delete the contents of the directories specified by BOOKKEEPING_DIR,
LOGS_DIR, and TMP_PRODUCTS_DIR. This is useful for keeping disk space usage to a minimum and will
force the workflow to fully rereduce the data each time the workflow is run.

The parameter RecipeFailureMode controls the behaviour in case that a recipe fails. If set to Continue,
the workflow will trigger the next recipes as usual, but without the output of the failing recipe, which in most
of the cases will lead to further failrues of other recipes without the user actually being aware of it. This mode
might be useful for unattended processing of large number of datasets. If set to Ask, a pop-up window will ask
whether the workflow should stop or continue. This is the default. Alternatively, the Stop mode will stop the
workflow execution immediately.

The parameter ProductExplorerMode controls whether the ProductExplorer actor will show its win-
dow or not. The possible values are Enabled, Disabled and Triggered. The later, recommended,
means that the ProductExplorer actor will be shown only at the end of the workflow execution.
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6.2 Workflow Actors

6.2.1 Simple Actors

Simple actors have workflow symbols that consist of a single (rather than multiple) green-blue rectangle. They
may also have a logo within the rectangle to aid in their identification. The following actors are simple actors:

• - The Data Organiser actor.

• - The Data Set Chooser actor (inside a composite actor).

• - The Fits Router actor

• - The Product Renamer actor.

• - The Product Explorer actor (inside a composite actor).

Access to the parameters for a simple actor is achieved by right-clicking on the actor and selecting Configure
Actor. This will open an “Edit parameters” window. Note that the Product Renamer actor is a jython
script (Java implementation of the Python interpreter) meant to be customised by the user (by double-clicking
on it).

6.2.2 Composite Actors

Composite Actors have workflow symbols that consist of multiple-layered green-blue rectangles. They generally
do not have a logo within the rectangle. A Composite Actor represents a combination of more Simple or
Composite Actors which hides over-complexity from the user in the top-level workflow. In the FORS2 workflow,
the following actors are composite actors:

• - The Initialise actor.

• - The Initialise Current DataSet actor.

• - The Product Explorer actor (contains the simple actor).
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• - The Initialise Current DataSet actor.

• - The MasterBias actor.

• - The ForsCalib actor.

• - The ResponseCurve actor.

• - The ForsScience actor.

• - The Close DataSet actor.

Composite Actors may also be expanded for inspection. To do this, right-click on the actor and select Open
Actor, which will expand the Composite Actor components in a new Reflex canvas window. If the Com-
posite Actor corresponds to a pipeline recipe, then the corresponding RecipeExecuter actor will be present
as a Simple Actor, and its parameters are accessible as for any other Simple Actor. Alternatively you may still
find Composite Actors, on which you need to repeat the first step to access the Recipe Executer.

6.2.3 Recipe Execution within Composite Actors

The FORS2 workflow contains Composite Actors to run pipeline recipes. This is in the most simple case due
to the SoF Splitter/SoF Accumulator7, which allow to process calibration data from different settings
within one given DataSet (e.g. lamp frames taken with different slits/masks). More complex Composite Actors
contain several actors (e.g. Recipe Executer).

Figure 6.1: This is the window you get when you choose Open Actor for the Composite Actor MasterBias.
This is the most simple case for a Composite Actor. Using Configure Actor on fors_bias_1 gives you
Fig. 6.2.

7SoF stands for Set of Files, which is an ASCII file containing the name (and path) of each input file and its category (e.g. BIAS).
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Table 6.1: The FORS2 pipeline actors and their contents
actor recipes description
MasterBias fors_bias create master bias

ForsPmosCalib fors_pmos_calib create master flat, determine coefficients for wave-
length calibration and correction of spatial distortion

ForsPmosScience fors_pmos_science reduce science data and standard star data

The central elements of any Reflex workflow are the RecipeExecuter actors that actually run the recipes.
One basic way to embed a RecipeExecuter in a workflow is shown in Fig 6.1, which is the most simple
version of a Composite Actor. The RecipeExecuter is preceded by an SofSplitter, and followed by
an SofAccumulator. The function of the SofSplitter is to investigate the incoming SoFs, sort them
by “purpose”, and create separate SoFs for each purpose. The RecipeExecuter then processes each of
the SoFs independently (unless they are actually the same files). Finally, the SofAccumulator packs all
the results into a single output SoF. The direct relation between the SofSplitter and SofAccumulator
is used to communicate the number of different SoFs created by the SofSplitter. A workflow will only
work as intended if the purpose of all the files a recipe needs as input is identical. The only exception to this
rule is that a purpose can also be “default”. In this case, the file is included in any output SoF created by the
SoFsplitter and SofAccumulator.

The reason for this scheme is best explained by an example. For a complex DataSet, the Data Organiser
might have selected a large number of individual raw lamp frames (arc and flat field). The different lamp
frames are to be used to calibrate different frames, e.g. the science frames and the standard star frames. The
Data Organiser determines and records this “purpose” of each lamp frame, and this information is included
in the DataSet and each SoF created from this DataSet. The FitsRouter directs all raw lamp frames to
the ForsCalib Composite Actor. The SofSplitter then creates SoFs, one for the lamp frames to be
used for the science frames, and (probably) separate ones for the lamp frames to be used for the standard star
observations. The fors_calib recipe creates one master flat field (and other products) for each SoF, and the
SofAccumulator then creates a SoF that contains all the products.

A RecipeExecuter actor is used in the workflow to run a single FORS2 pipeline recipe (e.g: in the
MasterBias actor the recipe fors_bias is executed). In order to configure the RecipeExecuters,
one has to first use Open Actor to get to the level of the recipe executors (see Fig. 6.1).

In Figure 6.2 we show the “Edit parameters” window for a typical RecipeExecuter actor, which can be
displayed by right-clicking on the actor and selecting Configure Actor. In the following we describe in
more detail the function of some of the parameters for a RecipeExecuter actor:

• The “recipe” parameter states the FORS2 pipeline recipe which will be executed.

• The “mode” parameter has a pull-down menu allowing the user to specify the execution mode of the actor.
The available options are:

– Run: The pipeline recipe will be executed, possibly in Lazy mode (see Section 6.2.4). This option
is the default option.

– Skip: The pipeline recipe is not executed, and the actor inputs are passed to the actor outputs.
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Figure 6.2: The “Edit parameters” window for a typical RecipeExecuter actor, the fors_bias_1 actor
which runs the fors_bias pipeline recipe.

– Disabled: The pipeline recipe is not executed, and the actor inputs are not passed to the actor
outputs.

• The “Lazy Mode” parameter has a tick-box (selected by default) which indicates whether the RecipeExecuter
actor will run in Lazy mode or not. A full description of Lazy mode is provided in Sect. 6.2.4.

• The “Recipe Failure Mode” parameter has a pull-down menu allowing the user to specify the behaviour
of the actor if the pipeline recipe fails. The available options are:

– Stop: The actor issues an error message and the workflow stops.

– Continue: The actor creates an empty output and the workflow continues.

– Ask: The actor displays a pop-up window and asks the user whether he/she wants to continue or
stop the workflow. This option is the default option.

• The set of parameters which start with “recipe param” and end with a number or a string correspond to
the parameters of the relevant FORS2 pipeline recipe. By default in the RecipeExecuter actor, the
pipeline recipe parameters are set to their pipeline default values. If you need to change the default pa-
rameter value for any pipeline recipe, then this is where you should edit the value8. For more information

8Some of the pipeline parameters are read from the GRISM_TABLEs, which contain grism-specific parameters. These cannot be
changed here.
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on the FORS2 pipeline recipe parameters, the user should refer to the FORS2 pipeline user manual (Izzo
et al. 20129).

The description of the remainder of the RecipeExecuter actor parameters are outside the scope of this
tutorial, and the interested user is referred to the Reflex User Manual for further details (Forchì 2012). Any
changes that you make in the “Edit parameters” window may be saved in the workflow by clicking the Commit
button when you have finished.

6.2.4 Lazy Mode

By default, all recipe executer actors in a pipeline workflow are “Lazy Mode” enabled. This means that when
the workflow attempts to execute such an actor, the actor will check whether the relevant pipeline recipe has
already been executed with the same input files and with the same recipe parameters. If this is the case, then the
actor will not execute the pipeline recipe, and instead it will simply broadcast the previously generated products
to the output port. The purpose of the Lazy mode is therefore to minimise any reprocessing of data by avoiding
data rereduction where it is not necessary.

One should note that the actor’s Lazy mode depends on the contents of the directory specified by
BOOKKEEPING_DIR and the relevant FITS file checksums. Any modification to the directory contents and/or
the file checksums will cause the corresponding actor when executed to run the pipeline recipe again, thereby
rereducing the input data.

The forced rereduction of data at each execution may of course be desirable. To force a rereduction of all data
for all RecipeExecuter actors in the workflow (i.e. to disable Lazy mode for the whole workflow), set the
EraseDirs parameter under the “Global Parameters” area of the workflow canvas to true. This will then
remove all previous results as well. To force a rereduction of data for any single RecipeExecuter actor
in the workflow (which will be inside the relevant composite actor), right-click the RecipeExecuter actor,
select Configure Actor, and uncheck the Lazy mode parameter tick-box in the “Edit parameters” window
that is displayed. If the Lazy mode is switched off for an actor, all subsequent actors that use products from that
one will also reprocess the data, as they see new products.

6.3 Workflow Steps

6.3.1 Step 1: Data Organisation And Selection

On clicking the button on the Reflex canvas, the workflow will highlight and execute the Initialise
actor, which among other things will clear any previous reductions if required by the user (see Section 6.1).

1. The DataOrganiser (DO) is the first crucial component of a Reflex workflow. The DO takes as
input RAWDATA_DIR and CALIB_DATA_DIR and it detects, classifies, and organises the files in these
directories and any subdirectories. The output of the DO is a list of “DataSets”. A DataSet is a special Set
of Files (SoF). A DataSet contains one or several science (or calibration) files that should be processed
together, and all files needed to process these data. This includes any calibration files, and in turn files

9Available at ftp://ftp.eso.org/pub/dfs/pipelines/fors/fors-pipeline-manual-5.3.pdf

ftp://ftp.eso.org/pub/dfs/pipelines/fors/fors-pipeline-manual-5.3.pdf
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that are needed to process these calibrations. Note that different DataSets might overlap, i.e. some files
might be included in more than one DataSet (e.g. BIAS files).

A DataSet lists three different pieces of information for each of its files, namely 1) the file name (includ-
ing the path), 2) the file category, and 3) a string that is called the “purpose” of the file. The DO uses
OCA10 rules to find the files to include in a DataSet, as well as their categories and purposes. The file cat-
egory identifies different types of files. A category could for example be FLAT_PMOS, LAMP_PMOS or
SCIENCE_PMOS. The purpose of a file identifies the reason why a file is included in a DataSet. The syn-
tax is action_1/action_2/action_3/ ... /action_n, where each action_i describes
an intended processing step for this file. The actions are defined in the OCA rules and contain the recipe
together with all file categories required to execute it (and predicted products in case of calibration data).
For example, a workflow might include two actions BIAS and CAL_PMOS. The former creates a mas-
ter bias from raw biases, and the later creates (among other products) a master flat from raw flats. The
CAL_PMOS action needs raw lamp frames (arc and flat field) and the master bias as input. In this case,
these biases will have the purpose BIAS/CAL_PMOS. The same DataSet might also include biases with
a different purpose, e.g. BIAS/SCIENCE_PMOS. Irrespective of their purpose the file category for all
these biases will be BIAS.

2. Next the DataSet Chooser displays the DataSets available in the “Select Data Sets” window, acti-
vating a vertical scroll bar on the right if necessary (see Figure 4.3). Sometimes you will want to reduce
a subset of these DataSets rather than all DataSets, and for this you may individually select (or de-select)
DataSets for processing using the tick boxes in the first column, and the buttons Select All and
Deselect All at the bottom left.

You may also highlight a single DataSet in blue by clicking on the relevant line. If you subsequently click
on Inspect Highlighted , then a “Select Frames” window will appear that lists the set of files that
make up the highlighted DataSet including the full filename and path for each file, the file category (from
the FITS header), and a selection tick box in the right column (see Figure 6.3). The tick boxes allow you
to edit the set of files in the DataSet which is useful if it is known that a certain calibration frame is of
poor quality (e.g: a poor raw flat-field frame). The list of files in the DataSet may also be saved to disk as
an ASCII file by clicking on Save As and using the file browser that appears.

By clicking on the line corresponding to a particular file in the “Select Frames” window, the file will be
highlighted in blue, and the file FITS header will be displayed in the text box on the right (see Figure 6.3),
allowing a quick inspection of useful header keywords. If you then click on Inspect , the workflow will
open the file in the selected FITS viewer application defined by the workflow parameter FITS_VIEWER.

To exit from the “Select Frames” window, click Continue , and to exit from the “Select DataSets”
window, click either Continue in order to continue with the workflow reduction, or Stop in order
to stop the workflow.

The categories and purposes of raw files are set by the DO, whereas the categories and purpose of products
generated by recipes are set by the RecipeExecuter (see Sect. 6.2.3). The file categories are used by the
FitsRouter to send files to particular processing steps or branches of the workflow (see below). The purpose

10OCA stands for OrganisationClassificationAssociation and refers to rules, which allow to classify the raw data according to the
contents of the header keywords, organise them in appropriate groups for processing, and associate the required calibration data for
processing. They can be found in the directory <install_dir>/share/esopipes/<pipeline-version>/reflex/,
carrying the extension.oca
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is used by the SofSplitter and SofAccumulator to generate input SoFs for the RecipeExecuter.
Note that while the DO includes files into a DataSet for a reason, and records this reason as the “purpose” of the
file, the workflow itself can use these files in a different manner. The SofSplitter and SofAccumulator
accept several SoFs as simultaneous input. The SofAccumulator creates a single output SoF from the inputs,
whereas the SofSplitter creates a separate output SoF for each purpose.

Figure 6.3: The “Select Frames” window with a single file from the current Data Set highlighted in blue, and the
corresponding FITS header displayed in the text box on the right. Hidden partially behind the “Select Frames”
window is the “Select DataSets” window with the currently selected DataSet highlighted in blue.
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6.3.2 Step 2: Creation Of Master Calibration Files

In this step of the workflow, the following FORS2 recipes are executed in the order listed below. Please refer
to the FORS2 pipeline user manual (Izzo et al. 2012: Sections 9 and 10) for the details of each recipe and the
algorithms employed:

1. The MasterBias actor will execute the FORS2 pipeline recipe fors_bias in order to create a com-
bined master bias frame from the set of raw bias frames

2. The ForsPmosCalib actor will execute the FORS2 pipeline recipe fors_pmos_calib in order to
create from the set of raw flat and arc frames a combined master flat frame as well as coefficients for
wavelength calibration and correction of spatial distortions.

6.3.3 Step 3: Science Reduction

The ForsPmosScience actor will execute the FORS2 pipeline recipe fors_pmos_science to apply sky
subtraction and extract the spectra. Please refer to the FORS2 pipeline user manual (Izzo et al. 2012: Sections
9 and 10) for the details of this recipe and the extraction algorithms employed.

6.3.4 Step 4: Output Organisation

After having processed the input data for a DataSet, the workflow highlights and executes the Product
Renamer actor, which, by default, will copy the defined final products of the ForsScience actor to the direc-
tory specified by END_PRODUCTS_DIR and rename them with names derived from the values of certain FITS
header keywords. Specifically, final products are renamed by default with names of the form
<HIERARCH.ESO.OBS.NAME>_<HIERARCH.ESO.PRO.CATG>.fits, with <HIERARCH.ESO.OBS.NAME>
and <HIERARCH.ESO.PRO.CATG> representing the values of the corresponding FITS header keywords
(<HIERARCH.ESO.OBS.NAME> is the name of the OB and <HIERARCH.ESO.PRO.CATG> is the cate-
gory of the product file). These names are fully configurable by right-clicking on the Product Renamer
actor, selecting Configure Actor, and then editing the string as appropriate. In some cases the keyword
<HIERARCH.ESO.OBS.TARG.NAME> (target name) may be more useful than <HIERARCH.ESO.OBS.NAME>.

For PMOS data the final products that are copied and renamed are (for better readbility we replace
<HIERARCH.ESO.OBS.NAME> by <OB_NAME>):

• 1-dimensional extracted spectra (<OB_NAME>_REDUCED_*, created only if spectra are identified and
can be extracted).
The individual spectra are provided as rows in a FITS file with as many extensions as input scientific ex-
posures. The correspondence between these rows and the 2-dimensional frames and/or slit identifications
can be obtained from <OB_NAME>_OBJECT_TABLE_SCI_PMOS.fits. All extracted spectra have
the same format.

– <OB_NAME>_REDUCED_SCI_PMOS.fits spectra

– <OB_NAME>_REDUCED_ERROR_SCI_PMOS.fits 1σ error of spectra
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– <OB_NAME>_REDUCED_SKY_SCI_PMOS.fits fitted sky spectra

• 1-dimensional polarization spectra (same format as 1-dimensional extracted spectra)
X may be any of ANGLE, I, L, Q, U, V according to the convention described in Izzo et al. (2012)

– <OB_NAME>_REDUCED_X_SCI_PMOS.fits extracted polarisation signals from the object-sources.

– <OB_NAME>_REDUCED_ERROR_X_SCI_PMOS.fits 1σ errors of the extracted polarisation
signals

• <OB_NAME>_OBJECT_TABLE_POL_SCI_PMOS.fits table with position information for detected
spectra, with the information from the extensions included within one table.

• 2-dimensional wavelength calibrated and distortion corrected frames (<OB_NAME>_MAPPED_*,
with as many extensions as input scientific exposures)

– <OB_NAME>_MAPPED_ALL_SCI_PMOS.fits frame without sky subtraction

– <OB_NAME>_MAPPED_SCI_PMOS.fits frame, sky-subtracted

– <OB_NAME>_MAPPED_SKY_SCI_PMOS.fits frame with fitted sky background

If sky alignment is requested (skyalign≥0) the following products are provided in addition to the ones listed
above:

• <OB_NAME>_DISP_COEFF_SCI_PMOS.fits adjustment of the input DISP_COEFF_PMOS table

• <OB_NAME>_SKY_SHIFTS_SLIT_SCI_PMOS.fits table with sky line shifts

• <OB_NAME>_WAVELENGTH_MAP_SCI_PMOS.fits wavelength map adjusted for sky line shifts

The following actors in this step of the workflow are concerned with the termination of the data flow for the
current DataSet and will highlight briefly as they are executed.

Finally, the Product Explorer window will appear as shown in Fig. 4.4 with a list of datasets on the left
menu. By unfolding the menu under each dataset, all the renamed products appear, and if one is interested
in the files, including all intermediate steps, that are used to produce that final product, just click on it and a
dependency tree will show the whole reduction chain.
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7 Frequently Asked Questions

• The error window fills the whole screen - how can I get to the Continue / Stop buttons?

Press the Alt key together with your left mouse button to move the window upwards and to the left. At
the bottom the Continue / Stop buttons will be visible. This bug is known but a fix has not yet been
found.

• Where are my intermediate pipeline products? Intermediate pipeline products are stored in the direc-
tory <TMP_PRODUCTS_DIR> (defined on the workflow canvas, under Setup Directories) and organised
further in directories by pipeline recipe.

• Can I use different sets of bias frames to calibrate my flat frames and science data? Yes. In fact this
is what is currently implemented in the workflow(s). Each file in a DataSet has a purpose attached to it
(Forchì (2012)). It is this purpose that is used by the workflow to send the correct set of bias frames to the
recipes for flat frame combination and science frame reduction, which may or may not be the same set of
bias frames in each case.

• Can I run Reflex from the command line? Yes, use the command:

esoreflex -n <workflow_path>/<workflow>.xml

The -n option will set all the different options to Kepler and the workflows that avoid any graphical display
(including pipeline interactive windows).

It is possible to specify workflow variables (those that appear in the workflow canvas) in the command
line. For instance, to set the raw data directory can be done with this command:

esoreflex -n -RAW_DATA_DIR <raw_data_path> \
<workflow_path>/<workflow>.xml

You can see all the command line options with the command ./esoreflex -h.

Note that this mode is not fully supported, and the user should be aware that the path to the workflow must
be absolute and even if no GUI elements are shown, it still requires a connection to the window manager.

• How can I add new actors to an existing workflow? You can drag and drop the actors in the menu
on the left of the Reflex canvas. Under Eso-reflex -> Workflow you may find all the actors
relevant for pipeline workflows, with the exception of the recipe executer. This actor must be manu-
ally instantiated using Tools -> Instantiate Component. Fill in the “Class name” field with
org.eso.RecipeExecuter and in the pop-up window choose the required recipe from the pull-
down menu. To connect the ports of the actor, click on the source port, holding down the left mouse
button, and release the mouse button over the destination port. Please consult the Reflex User Manual
(Forchì (2012)) for more information.

• How can I broadcast a result to different subsequent actors? If the output port is a multi-port (filled
in white), then you may have several relations from the port. However, if the port is a single port (filled in
black), then you may use the black diamond from the toolbar. Make a relation from the output port to the
diamond. Then make relations from the input ports to the diamond. Please note that you cannot click to
start a relation from the diamond itself. Please consult the Reflex User Manual (Forchì (2012)) for more
information.
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• How can I run manually the recipes executed by Reflex? If a user wants to re-run a recipe on the
command line he/she has to go to the appropriate reflex_book_keeping directory, which is generally
reflex_book_keeping/<workflow>/<recipe_name>_<number> There, subdirectories exist with the time
stamp of the recipe execution (e.g. 2013-01-25T12:33:53.926/). If the user wants to re-execute the most
recent processing he/she should go to the latest directory and then execute the script cmdline.sh.
Alternatively, to use some customized esorex command the user can execute

ESOREX_CONFIG="INSTALL_DIR/etc/esorex.rc"
PATH_TO/esorex --recipe-config=<recipe>.rc <recipe> data.sof

where INSTALL_DIR is the directory where Reflex and the pipelines were installed.

If a user wants to re-execute in the command line a recipe that used a given raw frame, the way to find the
proper data.sof in the bookkeeping directory is via grep <raw_file> */data.sof. Afterwards
the procedure is the same as before.

If a recipe is re-executed with the command explained before, the products will appear in the directory
from which the recipe is called, and not in the reflex_tmp_products or reflex_end_products directory, and
they will not be renamed. This doesn’t happen if you use the cmdline.sh script.

• Can I reuse the bookkeeping directory created by previous versions of the pipeline?

In general no. In principle, it could be reused if no major changes are in the pipeline. However there
are situations in which a previously created bookkeeping directory will cause problems due to pipeline
versions incompatibility. This is specially true if the parameters of the pipeline recipes have changed. In
that case, please remove completely the bookkeeping directory.

7.1 FORS specific questions

• There are no extracted spectra - why?

While this may happen for observations of extremely faint targets the most common case for this be-
haviour are PMOS observations from the lower chip, as the main target is usually placed close to the
centre of the field-of-view, which is on the upper chip.

• Does the pipeline combine different detectors chips into a common product?

No. The spectroscopic pipeline and Reflex workflow works only on files from the same detector chip.
Files from different detectors must not be mixed in the same sof.
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8 Troubleshooting

Figure 8.1: TheDataOrganizer interactive window reports an error “:No DataSets have been created, check
the data set and the OCA rules.”.

1. I downloaded the data from the ESO archive, put them into a new directory, tried to run Reflex
on them, but

(a) it crashes
The current release of FORS includes some additional data in the static calibration frames. The
recipes would chock if this data is not present. However, the ESO archive with CalSelector will
associate calibration data which is old and Reflex will pick the files either from the installed pipeline
static data or from the CalSelector in a non-deterministic way. In order to solve the issue, remove
the static calibration data downloaded from the archive (all the files starting with M.FORS2).
This may happen if one of the files was downloaded only partially (check for a file with the extension
fits.Z.part. You will have to download that file again in order to have an uncorrrupted file (and
remove the partial one).

(b) The DataOrganiser fails with the error message “:No DataSets have been created, check the
data set and the OCA rules.”(see Figure 8.1.)
This error may be due to the fact that the data provided by the ESO archive are compressed
(<filename>.fits.Z). Please remember to uncompress the data before running the workflow
in Reflex.

Also, please remember that the FORS2 workflow supports only spectro-polarimetric data (PMOS).
It is possible that your data consists entirely of IMG/IPOL/LSS/MOS/MXU observations, in which
case the Data Organiser actor will not construct any DataSets, showing the mentioned error
message.

2. The “Select DataSets” window displays my DataSets, but some/all of them are greyed out. What is
going on?

If a DataSet in the “Select DataSets” window is greyed out, then it means that the DataSet which was
constructed is missing some key calibration(s) (i.e. the DataSet is incomplete). To find out what calibra-
tion(s) are missing from a greyed out DataSet, click on the DataSet in question to highlight it in blue, and
then click on the button Inspect Highlighted . The “Select Frames” window that appears will
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report the category of the calibration products that are missing (e.g. MASTER_BIAS). From this the user
has then to determine the missing raw data (in this case bias frames). If static calibrations are missing the
mechanism unfortunately does not work, but such data should be found by reflex in
<install_directory>/calib/<pipeline_version>/cal

3. The pipeline fails with the error message “The wavelength solution at row <number> does not
increase monotonically, which is physically impossible. Try with new parameters”.

Non-monotonic dispersion relations are often due to spurious detections. In such cases try to decrease
wdegree and/or increase peakdetection. A further possibility is to decrease wradius.
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